
 

 

Computer Applications 

SEC-3, 4-Year Education Major 

L5: Power Point স্লাইডের ম ৌলিক উপাদান 

 

🌟 Presentation Tool: Slide Show ধারণা ও 

স্লাইডের ম ৌলিক উপাদান 

 

১. ভূল কা 

আধুনিক তথ্যপ্রযুক্তির যুগে মেডেডেশন সফটওয়্যার যযমি Microsoft PowerPoint, Google 

Slides, LibreOffice Impress ইতযানি নিক্ষা, েগেষণা, েযেসা, প্রনিক্ষণ এেং সরকানর–যেসরকানর 

সে যক্ষগেই গুরুত্বপূণ ণ ভূনমকা পালি কগর। 



এগুগলার মাধযগম তথ্যগক লিত্র, মিখা, িাটট, অ্যালনড শন ও  ালিল লেয়্া েযেহার কগর 

আকষ ণণীয়ভাগে উপস্থাপি করা যায়। 

যপ্রগেগেিগির িুটি যমৌনলক ধারণা হগলা— 

1. Slide Show 

2. Slide-এর Basic Elements 

নিগে িুটি নেষয়ই নেিগি েযাখ্যা করা হগলা। 

 

২. Slide Show-এর ধারণা (Concept of Slide 

Show) 

Slide Show কী? 

Slide Show হগলা এগকর পর এক স্লাইড প্রিি ণগির মাধযগম তথ্য উপস্থাপিার একটি ধারাোনহক 

প্রক্তিয়া, যা সাধারণত Full-Screen Mode-এ যিখ্া যায়। 

এটি েিা (Presenter) এেং িি ণগকর (Audience) মগধয যযাোগযাে সহে কগর, তথ্যগক িৃিযমাি 

(visual) ও আকষ ণণীয় কগর যতাগল। 

 

Slide Show-এর বৈলশষ্ট্য 

১. ধারাৈালিক (Sequential) স্লাইে েদশ টন 

যপ্রগেগেিগির স্লাইডগুগলা Speaker-এর নিয়ন্ত্রগণ ধারাোনহকভাগে যিখ্াগিা হয়। 

২. Full-screen Visual Display 

Slide Show েলাকালীি মনিির ো প্রগেক্টগর স্লাইড সমূ্পণ ণ পিণােগু়ে প্রিনি ণত হয়। 

৩. Multimedia Integration 

Slide Show-যত েযেহার করা যায়— 

 যিক্সি 

 ছনে 



 অনডও 

 নভনডও 

 এনিগমিি 

 গ্রাফ/োিণ 

৪. Presenter Control Tools 

Slide Show েলাকাগল েযেহার করা যায়— 

 Next/Back Slide Control 

 Laser Pointer 

 Pen/Highlighter 

 Presenter View (Notes সহ) 

৫. Automation Features 

 Auto-timing 

 Slide transition effects 

 Loop presentation (পুিরােনৃি) 

 

Slide Show-এর ৈযৈিারডেত্র 

 যেনণকগক্ষর পাঠিাি 

 েগেষণাপে উপস্থাপিা 

 েযেসানয়ক সভা 

 পণয প্রিি ণিী 

 প্রনিক্ষণ/Workshop 

 ইগভে/অিুষ্ঠাি পনরোলিা 

 

৩. স্লাইে (Slide) কী? 

স্লাইড হগলা যপ্রগেগেিগির একটি স্বতন্ত্র পষৃ্ঠা ো যেম, যযখ্াগি নিনিণষ্ট তথ্য ো োতণা উপস্থাপি 

করা হয়। 

একটি সমূ্পণ ণ যপ্রগেগেিি অগিকগুগলা স্লাইগডর সমটষ্ট। 

 



৪. স্লাইডের ম ৌলিক উপাদান (Basic 

Elements of a Slide) 

প্রনতটি ইগফনক্টভ স্লাইড নকছু যমৌনলক উপািাি নিগয় েটঠত। এগুগলা হল— 

 

৪.১ Slide Title (লশডরানা ) 

 স্লাইগডর মূল নেষয়েস্তু নিগিণি কগর। 

 সাধারণত উপগরর যকগে ো োম পাগি থ্াগক। 

 নিগরািাম সংনক্ষপ্ত ও স্পষ্ট হওয়া উনেত। 

উদািরণ: “Impact of Climate Change”, “Data Analysis Methods” 

 

৪.২ Text Content ( ূি মিখা/তথ্য) 

 েুগলি পগয়ে েযেহার করা হয় 

 যছাি োকয/মূল পগয়ে েযেহারই উিম 

 ফে সাইে সাধারণত ২৪–৩০ pt ো তার যেনি হওয়া উনেত 

 

৪.৩ Images / Graphics (ছলৈ/গ্রালফক্স) 

নভেযুয়াল উপািাি তথ্যগক স্মরণগযােয কগর। েযেহৃত হগত পাগর— 

 ছনে 

 আইকি 

 ডায়াগ্রাম 

 ইলাগেিি 

 Infographic 

ছনের মাি ভাগলা হওয়া েরুনর। 

 

৪.৪ Charts & Graphs (িাটট/গ্রাফ) 



পনরসংখ্যাি ো তুলিামূলক তথ্য উপস্থাপগি েযেহার করা হয়— 

 Bar Chart 

 Pie Chart 

 Line Graph 

 Table 

গ্রাফগুগলা স্পষ্ট ও সহেগোধয হওয়া উনেত। 

 

৪.৫ Animations (অ্যালনড শন) 

 যিক্সি/ইগমে আসা-যাওয়ার ইগফক্ট 

 তথ্য ধাগপ ধাগপ যিখ্াগিার েিয উপগযােী 

 অনতনরি েযেহার নেভ্রানিকর হগত পাগর 

 

৪.৬ Slide Background (স্লাইে ৈযাকগ্রাউন্ড) 

 স্লাইগডর যপছগির রঙ ো নডোইি 

 সাধারণ রঙ ো হালকা যিক্সোর যসরা 

 েযাকগ্রাউন্ড যযি কিগিেগক আ়োল িা কগর 

 

৪.৭ Multimedia (অ্লেও/লভলেও) 

 নভনডও নিপ 

 Sound Effect 

 Narration 

েটিল নেষয় সহগে যোঝাগত েযেহার করা যায়। 

 

৪.৮ Shapes and SmartArt 

 Flowchart 

 Process Diagram 

 Hierarchical Structure 

সংেটঠত তথ্য যিখ্াগত অতযি কায ণকর। 



 

৪.৯ Footer Elements (পাদটীকা অ্ংশ) 

Footer-এ েযেহার করা যায়— 

 Slide Number 

 Date 

 Organization Name 

 Logo 

 

৫. কার্ টকর স্লাইে বতলরর লনডদটলশকা 

(Principles of Good Slide Design) 

✔ এক স্লাইডে একটট েধান আইলেয়্া 

✔ ৈুডিট পডয়্ডে সংডেডপ তথ্য 

✔ েডয়্ােন অ্নুর্ায়্ী ছলৈ/িাটট ৈযৈিার 

✔ পাঠডর্াগ্য ফে ও স তা ৈোয়্ রাখা 

✔ পর্ টাপ্ত সাদা অ্ংশ (white space) রাখা 

✔ অ্লত অ্যালনড শন এডাডনা 

✔ রডের কনট্রাস্ট ৈোয়্ রাখা (Light background & Dark text) 

 

৬. Slide Layout (স্লাইে মিআউট) 

স্লাইড সাোগিার নকছু স্ট্যান্ডাডণ যলআউি— 

 Title Slide 



 Title + Content 

 Two-Column Layout 

 Comparison Layout 

 Picture with Caption 

 Blank Layout 

 

৭. Slide Show েস্তুত ও উপস্থাপডনর ধাপ 

১. লৈষয়্ লনধ টারণ 

২. স্লাইে বতলর 

৩. কনডটে মর্াগ্ করা 

৪. ট্রানজেশন ও অ্যালনড শন র্ুক্ত করা 

৫. Slide Show Preview 

৬. Presenter View Notes ৈযৈিার 

৭. েডেক্টডর উপস্থাপন 

 

৮. উপসংিার 

Slide Show ও Slide-এর যমৌনলক উপািাি আধুনিক যপ্রগেগেিগির কায ণকানরতা ও যসৌন্দয ণ 

নিধ ণারগণ অতযি গুরুত্বপূণ ণ। সটঠক যলআউি, স্পষ্ট যলখ্া, যথ্াযথ্ গ্রানফক্স ও সুিৃঙ্খল প্রোহ 

(flow) একটি সফল উপস্থাপিার মূল নভনি। প্রযুক্তির অগ্রেনতর ফগল যপ্রগেগেিি এখ্ি আরও 

ইোরঅযাকটিভ, মানিনমনডয়া-সমদৃ্ধ এেং িি ণক–োন্ধে হগয় উগঠগছ। 

 

⭐ MCQ SET – 55 Questions (with Answers) 

(Slide Show Concept, Presentation Tools, Basic Slide Elements) 

 



A. Slide Show – Basic Concepts 

১. Slide Show কী? 

A) Word typing software 

B) ধারাোনহক স্লাইড প্রিি ণি প্রক্তিয়া 
C) Video conversion 

D) File compression tool 

✔ উত্তর: B 

২. Slide Show সাধারণত মকান ম াডে িািাডনা িয়্? 

A) Window mode 

B) Full-screen mode 

C) Edit mode 

D) Split view 

✔ উত্তর: B 

৩. Presentation সফটওয়্যাডরর উদািরণ— 

A) MS Word 

B) MS Excel 

C) PowerPoint 

D) Notepad 

✔ উত্তর: C 

৪. Google Slides মকান ধরডনর সফটওয়্যার? 

A) Offline 

B) Online cloud-based 

C) Programming tool 

D) Graphics editor 

✔ উত্তর: B 

৫. Slide Show শুরু করার সাধারণ শটটকাট (PowerPoint) 

A) Ctrl + D 

B) F5 

C) Alt + F4 

D) Shift + Delete 

✔ উত্তর: B 



৬. Slide Show-এর  াধযড  মকান উডেশয পূরণ িয়্? 

A) Data calculation 

B) Program coding 

C) Information presentation 

D) Data encryption 

✔ উত্তর: C 

৭. Presenter View-মত কী মদখা র্ায়্? 

A) Only audience view 

B) Presenter notes + current slide + next slide 

C) Only notes 

D) Only animations 

✔ উত্তর: B 

৮. মকানটট Slide Navigation টুি? 

A) Arrow keys 

B) Mouse click 

C) Presenter remote 

D) সেগুগলা 

✔ উত্তর: D 

৯. Continuous looping slideshow বতলর করা র্ায়্— 

A) Slide Sorter 

B) Slide Show Settings 

C) File Menu 

D) Help Menu 

✔ উত্তর: B 

১০. Slide transition কী? 

A) Slide design 

B) Slide েিলাগিার visual effect 

C) Audio effect 

D) None 

✔ উত্তর: B 

 



B. Slide – Basic Elements 

১১. স্লাইডের েধান উপাদান মকানটট? 

A) File 

B) Email 

C) Title 

D) Folder 

✔ উত্তর: C 

১২. Title Slide সাধারণত কী ধারণ কডর? 

A) যকেল ছনে 

B) যকেল নভনডও 

C) নেষয়নিগরািাম ও উপনিগরািাম 

D) যকাড 

✔ উত্তর: C 

১৩. Slide-এর text সাধারণত মক ন িওয়্া উলিত? 

A) িীর্ ণ অিুগেি 

B) Bulleted points 

C) যকাড ব্লক 

D) অসংলগ্ন পাঠয 

✔ উত্তর: B 

১৪. Presentation-এ ছলৈ মর্াগ্ করা িয়্ মকন? 

A) Slide ভারী করগত 

B) তথ্য পনরষ্কার ও আকষ ণণীয় করগত 

C) ফাইল সাইে ো়োগত 

D) None 

✔ উত্তর: B 

১৫. Charts/Graphs ৈযৈিার করা িয়্— 

A) যিক্সি লুকাগত 

B) েক্তৃতা ো়োগত 

C) তুলিামূলক ো পনরসংখ্যানিক তথ্য যিখ্াগত 



D) Background ততনর করগত 

✔ উত্তর: C 

১৬. মকানটট Slide Element? 

A) Table 

B) SmartArt 

C) Picture 

D) সেগুগলা 

✔ উত্তর: D 

১৭. Footer-এ সাধারণত কী থ্াডক? 

A) Title 

B) Slide number 

C) Background image 

D) Animation 

✔ উত্তর: B 

১৮. স্লাইডে Multimedia ৈিডত মৈাঝায়্— 

A) Audio 

B) Video 

C) Animation 

D) সেগুগলা 

✔ উত্তর: D 

১৯. Slide Layout কী? 

A) Slide-এর স্ট্াইল 

B) Slide-এর ফে 

C) Slide-এর উপািাি সাোগিার ধরি 

D) Transition effect 

✔ উত্তর: C 

২০. SmartArt মকাথ্ায়্ ৈযৈহৃত িয়্? 

A) Data storage 

B) Visual diagram ততনর 

C) Audio editing 



D) Slide deletion 

✔ উত্তর: B 

 

C. Presentation Tools & Features 

২১. মকান লভউডত স্লাইে একডত্র মদখা র্ায়্? 

A) Slide Show View 

B) Slide Sorter View 

C) File View 

D) Menu View 

✔ উত্তর: B 

২২. Notes Pane-এর ৈযৈিার— 

A) Video insert করা 

B) Presenter’s note যলখ্া 

C) Background পনরেতণি 

D) Animation মুছা 

✔ উত্তর: B 

২৩. Slide Master-এর কাে— 

A) Transition যসি করা 

B) ঐকযেদ্ধ (uniform) theme নডোইি করা 
C) Data analysis 

D) িতুি Slide ততনর 

✔ উত্তর: B 

২৪. Font size সাধারণত কত রাখা উলিত? 

A) 8–10 pt 

B) 12–14 pt 

C) 24 pt ো তার যেনি 

D) 6 pt 

✔ উত্তর: C 

২৫. Hyperlink ৈযৈিার করা িয়্— 



A) ফাইল মুছগত 

B) ছনে ে়ে করগত 

C) অিয Slide, File ো Website-এ যযগত 

D) Animation ধীর করগত 

✔ উত্তর: C 

২৬. Slide Background মৈলশ উজ্জ্বি িডি— 

A) Text প়েগত সুনেধা 

B) Text প়েগত অসুনেধা 

C) Animation োগ়ে 

D) File যছাি হয় 

✔ উত্তর: B 

২৭. Template কী? 

A) Blank document 

B) Pre-designed slide structure 

C) Image editor 

D) Font style 

✔ উত্তর: B 

২৮. Theme কী? 

A) Slide animation 

B) Slide color + font + design-এর সমনিত যসি 

C) Folder name 

D) Code library 

✔ উত্তর: B 

২৯. Which element makes content appear step-by-step? 

A) Layout 

B) Animation 

C) Transition 

D) Footer 

✔ উত্তর: B 

৩০. Which effect is applied between two slides? 



A) Transition 

B) Animation 

C) Audio 

D) Highlight 

✔ উত্তর: A 

 

D. Slide Design Principles 

৩১. Effective slide design-এর বৈলশষ্ট্য নয়্— 

A) কম যিক্সি 

B) স্পষ্ট ছনে 

C) অনতনরি Animation 

D) সািা োয়ো (White Space) 

✔ উত্তর: C 

৩২. Good presentation requires— 

A) Heavy text 

B) Clear visual hierarchy 

C) No visuals 

D) No color 

✔ উত্তর: B 

৩৩. মকানটট ভাডিা practice? 

A) Very small font 

B) Too many colors 

C) Limited colors + high contrast 

D) Full paragraph text 

✔ উত্তর: C 

৩৪. Audience-friendly slide-এ থ্াকা উলিত— 

A) Main ideas only 

B) Full essay 

C) Coded sentences 

D) Dense text 

✔ উত্তর: A 



৩৫. White space-এর উডেশয— 

A) Slide খ্ানল যিখ্াগিা 

B) প়োর সুনেধা েকৃ্তদ্ধ 

C) Transition েন্ধ করা 
D) None 

✔ উত্তর: B 

 

E. Multimedia & Interaction 

৩৬. Video insert করা র্ায়্— 

A) Insert → Video 

B) File → Save 

C) View → Zoom 

D) Tools → Spell check 

✔ উত্তর: A 

৩৭. Slide Show িিাকাডি Pointer লিডসডৈ ৈযৈিার করা র্ায়্— 

A) Arrow keys 

B) Laser pointer 

C) Pen tool 

D) সেগুগলা 

✔ উত্তর: D 

৩৮. Audio narration সাধারণত ৈযৈহৃত িয়্— 

A) Automated lessons 

B) Manual typing 

C) Data entry 

D) Printing 

✔ উত্তর: A 

৩৯. Slide Show িুপ করডত ৈযৈহৃত িয়্— 

A) Slide Master 

B) Setup Slide Show 

C) Design Tab 



D) Notes Page 

✔ উত্তর: B 

৪০. Animation Pane ৈযৈহৃত িয়্— 

A) Video edit 

B) Animation নিয়ন্ত্রণ 

C) Slide duplicate 

D) Background change 

✔ উত্তর: B 

 

F. Extra Conceptual MCQs 

৪১. মকানটট মেডেডেশন ফাইি ফর যাট? 

A) .pptx 

B) .mp3 

C) .jpg 

D) .txt 

✔ উত্তর: A 

৪২. Slide duplicating shortcut— 

A) Ctrl + Z 

B) Ctrl + D 

C) Alt + F4 

D) F1 

✔ উত্তর: B 

৪৩. File → Export ৈযৈিার করা িয়্— 

A) Slide delete 

B) File format পনরেতণি 

C) Background edit 

D) Presentation view 

✔ উত্তর: B 

৪৪. Presenter Notes মকাথ্ায়্ মদখা র্ায়্? 



A) Normal View 

B) Notes View 

C) Slide Show View 

D) File manager 

✔ উত্তর: B 

৪৫. Slide Rehearse Timing ৈযৈহৃত িয়্— 

A) Time management করার েিয 

B) Slide delete করার েিয 

C) Template ততনরর েিয 

D) Zoom করার েিয 

✔ উত্তর: A 

৪৬. মকানটট non-text element? 

A) ছনে 

B) Shape 

C) Chart 

D) সেগুগলা 

✔ উত্তর: D 

৪৭. Slide Design-এ font size খুৈ মছাট িডি— 

A) Audience সহগে প়েগে 

B) Audience প়েগত পারগে িা 

C) Animation ো়েগে 

D) যপ্রগেগেিি দ্রতু হগে 

✔ উত্তর: B 

৪৮. Slide Show ৈন্ধ করার shortcut— 

A) Esc 

B) Ctrl + N 

C) Alt + Enter 

D) Shift + Tab 

✔ উত্তর: A 

৪৯. Which element gives systematic flow? 



A) Animation only 

B) SmartArt 

C) Background 

D) None 

✔ উত্তর: B 

৫০. Best slide structure follows— 

A) One idea per slide 

B) Many ideas per slide 

C) No idea 

D) Full essays 

✔ উত্তর: A 

 

G. Bonus MCQs (৫টট) 

৫১. Design Template পলরৈতটন করা িয়্— 

A) Home tab 

B) Design tab 

C) View tab 

D) Insert tab 

✔ উত্তর: B 

৫২. Slide Theme কী? 

A) Only font style 

B) Slide color + font + background-এর একক্তেত যসি 

C) Slide transition 

D) Audio file 

✔ উত্তর: B 

৫৩. Insert → Shape ৈযৈিার করা িয়্— 

A) Chart ততনর 

B) Diagram insert 

C) Geometry shapes যযাে 

D) File save 

✔ উত্তর: C 



৫৪. Slide Show-এ Presenter Notes মক মদখডত পাডর? 

A) Only presenter 

B) Audience 

C) Both 

D) None 

✔ উত্তর: A 

৫৫. Slide Background খুৈ উজ্জ্বি িডি— 

A) Text ভাগলা যিখ্া যায় 

B) Text যিখ্া কটঠি হয় 

C) Animation োগ়ে 

D) File size কগম 

✔ উত্তর: B 

 

🌟 SAQ (Short Answer Questions – ৩–৫ 

নম্বর) 

⭐  ডেি েশ্ন + উত্তরসি 

 

SAQ–1: Slide Show কী? 

উত্তর: 

Slide Show হগলা যপ্রগেগেিগির স্লাইডগুগলাগক ধারাোনহকভাগে Full-screen mode–এ 

প্রিি ণগির একটি প্রক্তিয়া। এগত যিক্সি, ছনে, োিণ, নভনডও, অযানিগমিি ইতযানি েযেহার কগর 

যকাগিা নেষয় আকষ ণণীয়ভাগে উপস্থাপি করা যায়। নিক্ষা, েযেসা, েগেষণা উপস্থাপিায় এটি েহুল 

েযেহৃত। 

 

SAQ–2: Presentation Tool কী? উদািরণ দাও। 



উত্তর: 

Presentation Tool হগলা এমি সফিওয়যার যার মাধযগম স্লাইড আকাগর তথ্য ততনর ও উপস্থাপি 

করা হয়। 

উদািরণ: Microsoft PowerPoint, Google Slides, LibreOffice Impress। 

 

SAQ–3: স্লাইে (Slide) কী? 

উত্তর: 

স্লাইড হগলা যপ্রগেগেিগির একটি পথৃ্ক পষৃ্ঠা ো যেম, যযখ্াগি নিনিণষ্ট তথ্য ো োতণা গ্রানফকযাল 

ও যিক্সি আকাগর উপস্থানপত হয়। একটি সমূ্পণ ণ যপ্রগেগেিি অগিকগুগলা স্লাইগডর সমটষ্ট। 

 

SAQ–4: Slide Title-এর ভূল কা কী? 

উত্তর: 

Slide Title স্লাইগডর মূল নেষয়েস্তু নিগিণি কগর। এটি স্লাইগডর িীগষ ণ থ্াগক এেং িি ণকগক নেষগয়র 

প্রনত মগিাগযােী কগর। একটি ভাগলা Title সংনক্ষপ্ত, পনরষ্কার ও নেষয়-নিগিণিক হওয়া উনেত। 

 

SAQ–5: Slide Transition কী? 

উত্তর: 

Slide Transition হগলা এক স্লাইড যথ্গক আগরক স্লাইগড যাওয়ার সময় প্রিনি ণত নেগিষ visual 

effect। Transition যপ্রগেগেিগির েনত ও িান্দনিকতা ো়োয়, তগে অনতনরি েযেহার নেরক্তিকর 

হগত পাগর। 

 

SAQ–6: Animation এৈং Transition-এর পাথ্ টকয লিডখা। 

উত্তর: 

 Animation: স্লাইগডর যভতগরর উপািাি (যিক্সি/ছনে) কীভাগে আসগে ো ি়েগে তা 

নিয়ন্ত্রণ কগর। 

 Transition: এক স্লাইড যথ্গক অিয স্লাইগড যাওয়ার সময় িৃিযমাি effect। 



 

SAQ–7: Notes Pane-এর ৈযৈিার কী? 

উত্তর: 

Notes Pane েিার েিয েযাখ্যা ো নিগিণিিা নলগখ্ রাখ্ার োয়ো। Slide Show েলাকাগল িি ণক তা 

যিখ্গত পায় িা, তগে Presenter View-যত েিা যিখ্গত পাগরি। 

 

SAQ–8: Slide Layout কী? 

উত্তর: 

Slide Layout হগলা স্লাইগড যিক্সি, ছনে, নিগরািাম, োিণ ইতযানি উপািাি কীভাগে সাোগিা হগে 

তার পনরকনিত কাঠাগমা। যযমি—Title Slide, Title + Content, Two Column, Blank Layout 

ইতযানি। 

 

SAQ–9: SmartArt কী? 

উত্তর: 

SmartArt হগলা PowerPoint-এর নভেযুয়াল ডায়াগ্রাম িুল, যা েযেহার কগর প্রক্তিয়া, সম্পকণ, 

হায়ারানকণ, সাইগকল ইতযানি গ্রানফকযালভাগে উপস্থাপি করা যায়। এটি েটিল ধারণাগক 

সহেভাগে তুগল ধগর। 

 

SAQ–10: Slide Master-এর ভূল কা কী? 

উত্তর: 

Slide Master পুগরা যপ্রগেগেিগির ঐকযৈদ্ধ লেোইন নিয়ন্ত্রণ কগর। ফে, রঙ, েযাকগ্রাউন্ড, 

যলাগো ইতযানি Slide Master-এ যসি করগল সে স্লাইগড একই নডোইি প্রগয়াে হয়। 

 

 

🌟 LAQ (Long Answer Questions – ৮–১২ 

নম্বর) 



⭐  ডেি েশ্ন + উত্তরসি 

 

LAQ–1: Slide Show-এর ধারণা ও বৈলশষ্ট্য লৈশডদ ৈযাখযা 

কডরা। 

উত্তর: 

Slide Show হগলা স্লাইডগুগলার ধারাোনহক উপস্থাপিা, যা সাধারণত Full-screen mode-এ প্রিনি ণত 

হয়। এটি েিা ও িি ণগকর মগধয যযাোগযাে সহে কগর এেং তথ্যগক িৃিযমাি, আকষ ণণীয় ও 

স্মরণগযােয কগর। 

Slide Show-এর বৈলশষ্ট্য: 

1. Sequential Display: স্লাইডগুগলা ধারাোনহকভাগে প্রিনি ণত হয়। 

2. Full-screen View: মনিির ো প্রগেক্টগর পূণ ণ পিণােগু়ে স্লাইড যিখ্া যায়। 

3. Multimedia Support: ছনে, নভনডও, অযানিগমিি, গ্রাফ, অনডও েযেহার করা যায়। 

4. Presenter Tools: Laser pointer, pen tool, presenter view েযেহাগরর সুনেধা থ্াগক। 

5. Automation: Auto-timing, loop show ও slide transition েযেহার করা যায়। 

6. Audience Engagement: িি ণক সহগে নেষয়টি েুঝগত পাগর। 

Slide Show আধুনিক নিক্ষা, েযেসা ও তেজ্ঞানিক উপস্থাপিায় অতযি কায ণকর। 

 

LAQ–2: স্লাইডের ম ৌলিক উপাদানগুডিা লৈস্তালরতভাডৈ 

ৈযাখযা কডরা। 

উত্তর: 

প্রনতটি কায ণকর স্লাইড নকছু যমৌনলক উপািাগির সমিগয় েটঠত— 

১. Title (লশডরানা ) 

স্লাইগডর মূল ধারণা নিগিণি কগর এেং িি ণগকর মগিাগযাে আকষ ণণ কগর। 

২. Text Content 

েুগলগিড পগয়গে সংগক্ষগপ তথ্য তুগল ধরা হয়। ে়ে অিুগেি এ়োগিা উনেত। 



৩. Images/Graphics 

নভেযুয়াল উপািাি যযমি ছনে, আইকি, ডায়াগ্রাম তথ্যগক স্পষ্ট কগর ও িৃটষ্টিন্দি কগর। 

৪. Charts & Graphs 

পনরসংখ্যাি ো তুলিামূলক তথ্য উপস্থাপগি োর োিণ, লাইি গ্রাফ, পাই োিণ েযেহৃত হয়। 

৫. SmartArt ও Shapes 

প্রক্তিয়া, সম্পকণ, কাঠাগমা ও হায়ারানকণ যিখ্াগত েযেহৃত হয়। 

৬. Multimedia Elements 

নভনডও, অনডও, অযানিগমিি েযেহার কগর েটিল নেষয় সহে করা যায়। 

৭. Background 

হালকা, মাক্তেণত েযাকগ্রাউন্ড স্লাইডগক সুন্দর কগর যতাগল। 

৮. Footer Elements 

Slide Number, Date, Organization Name ো Logo থ্াকগত পাগর। 

৯. White Space 

স্লাইগড যগথ্ষ্ট ফাাঁকা স্থাি যরগখ্ কিগিে পনরষ্কার ও সুেটঠত রাখ্া হয়। 

এই উপািািগুগলা নমগলই একটি যপিািার ও কায ণকর স্লাইড ততনর হয়। 

 

LAQ–3: Presentation Tool-এর ভূল কা এৈং Slide Design-

এর ম ৌলিক নীলতগুডিা আডিািনা কডরা। 

উত্তর: 

Presentation Tool যযমি PowerPoint ো Google Slides আধুনিক তথ্য উপস্থাপিার গুরুত্বপূণ ণ 

মাধযম। এগুগলা নেনভন্ন উপািাি—যিক্সি, ছনে, গ্রাফ, নভনডও—একগে সাক্তেগয় নভেযুয়াল 

যপ্রগেগেিি ততনর করগত সাহাযয কগর। 



Presentation Tool-এর ভূল কা: 

1. স্লাইে বতলর ও সম্পাদনা 

2. লিত্র, গ্রাফ ও  ালিল লেয়্া র্ুক্ত করা 

3. Transition ও animation েডয়্াগ্ 

4. Presenter View ৈযৈিার 

5. Template ও Theme ৈযৈস্থাপনা 

6. Professional লেোইন বতলর 

Slide Design-এর ম ৌলিক নীলত: 

 One idea per slide (এক স্লাইগড এক মূল ধারণা) 

 Large readable fonts (২৪–৩০ pt ো যেনি) 

 উচ্চ কনট্রাস্ট (Light background + Dark text) 

 ৈুডিট পডয়্ডে সংডেপ তথ্য 

 সটঠক ছলৈ/িাটট ৈযৈিার 

 সরিতা ৈোয়্ রাখা (Minimalism) 

 Overflow মটক্সট পলরিার করা 

 সাদা স্থান (White space) রাখা 

এই িীনতগুগলা অিুসরণ করগল স্লাইড আরও সুন্দর, আকষ ণণীয় ও যোধেময হয়। 

 

LAQ–4: Slide Layout, Slide Master এৈং Theme-এর 

কার্ টকালরতা ৈযাখযা কডরা। 

উত্তর: 

Slide Layout: 

এটি স্লাইগড যিক্সি, ছনে, নিগরািাম ইতযানি কীভাগে সাোগিা হগে তার নপ্র-নডফাইিড কাঠাগমা। 

যযমি— 

 Title Slide 

 Title + Content 

 Two Column 

 Comparison Layout 

 Blank Layout 

Slide Master: 



Slide Master হগলা পুগরা যপ্রগেগেিগির নডোইি কগরাল যসোর। 

এখ্াগি ফে, রঙ, েযাকগ্রাউন্ড, যলাগো, Placeholder ইতযানি যসি করগল সে স্লাইগড 

ঐকযেদ্ধভাগে প্রনতফনলত হয়। 

এর ফগল একসাগথ্ পুগরা যপ্রগেগেিগির স্ট্াইল পনরেতণি করা যায়। 

Theme: 

Theme হগলা রঙ, ফে, েযাকগ্রাউন্ড ও যলআউগির সমনিত নডোইি যসি। 

এটি presentation-যক যপিািার রূপ যিয় এেং consistency েোয় রাগখ্। 

কার্ টকালরতা: 

 সমনিত নডোইি 

 দ্রতু যপ্রগেগেিি ততনর 

 নভেযুয়াল সামঞ্জসযতা 

 যপিািার লুক ও অিুভূনত 
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